AVID SETUP AND BASIC OPERATION
REMEMBER: You can right-click on anything in the software and choose “What’s This?” from the pop-up
menu to be taken to the user manual’s page explaining that function or item.
•

Open Avid by clicking its taskbar icon

•

At the Project Selection window click the folder button next to ‘Location’ to navigate to your
module’s volume on the server.

or double-clicking the desktop shortcut.

•

Locate the designated project folder within the module’s drive – This may be a single Avid
Projects folder or there may be a different folder for each week/task/exercise. Your lecturer will
advise you if you’re unsure.

•

Click ‘open’.

•

Back at the Project Selection window click on the ‘New Project’ button.

•

Set your project format – In the UK this should be either a 50 or 25 fps format. At the Uni you
should usually be using 1080p/25. If your camera has been set to a different format you will get
an error message when you try to transcode your clips. If this happens come and see a
technician to decide how to proceed.

1. NAME YOUR PROJECT! Don’t leave it named ‘New Project’. The name should start with the module
ID, followed by your group name/number.
2. Click ‘OK’ to create the project and load it.
The Interface
These are the main windows of the Avid interface;

1. The Bin container.
1a. The Project Sidebar. The bin container consists of two
parts. On the left is a (hide-able) sidebar aka the project
window; a list of all the bins (and folders) in your project.
At the top there’s a quick search text box to help you find
bins in large projects, and a fast menu button which gives
access to some
key functions
directly within
the window.
You can also invoke the fast menu by right-clicking anywhere in the project window (1a).
When you double-click a bin icon in the project sidebar it opens the bin in the right-hand area of the
bin container (1b). If you open multiple bins they will be tabbed at the top of the window so that you
can choose which is visible.
1b. The Bin/s.
Bins are where you keep your footage (and music, sound effects, titles etc) and sequences. You can
create folders in the project window in order to group and arrange bins but you can’t store clips
directly in folders, only in bins.
There are three buttons at the top of
the bin that allow you to change how
the contents of the bin are displayed,
either as text list view, thumbnail, or
‘Script’ mode. You can customise and save the views you use most frequently and they will then show
up in the drop down menu to the left of the buttons. When in Frame View (thumbnails) there is a slider
to adjust the size of the thumbnail in the bin. You can change the visible thumbnail frame by selecting
the thumbnail and using keyboard commands to move to the desired frame.
Next along there is another Search field to help you quickly locate items in the bin.
Lastly, there is also another ‘Fast Menu’ button here, giving access to the most relevant menu
commands from directly within the bin. Once again, you can also invoke this menu by right-clicking
anywhere in the bin.
2. The Composer Window.
This is where you view your clips
and your edited sequence. The
left hand viewer is the SOURCE
MONITOR and is where your clips
are viewed and the right hand
viewer is the RECORD MONITOR
and shows your edited sequence.
Above each viewer is a display of
the currently loaded object’s
name and if you click on this it will reveal a list of the previously loaded items.
In the middle at the top are numerical displays that will usually show the current timecode of the
playhead but can be configured to show various other counters.
Beneath each viewer is a timeline bar that shows the position of the playhead within the clip/sequence
and any marks or locators you have added.

Underneath each timeline bar is a set of buttons for controlling playback within the viewer, for marking
sections of the clip or sequence (an integral part of the editing process), and for performing some other
associated functions.

The most important are the IN and OUT buttons and the yellow and red SPLICE-IN and OVERWRITE edit
buttons. These put the object loaded in the Source Viewer into the timeline.
The SPLICE-IN (or INSERT) button will move the objects in the timeline around to accommodate the
new item. The OVERWRITE button will simply overwrite whatever is in the way.
3. The Timeline window.

This is where you build your edit. It shows a graphical representation of the material in your
sequence.
Along the top of the window are various function buttons, some of which are duplicated elsewhere
in the interface. Avid allows you to customise the buttons to a great extent and there are usually at
least two different ways of accessing a particular function.

The first two buttons are the SEGMENT MODE and TRIM MODE Smart Tool buttons. They’re called
Smart Tools because when fully activated (both red and yellow modes checked in the right-click
pop-up menu) the mouse pointer will change its icon and associated function depending on where
in the timeline it is.
RED SEGMENT MODE, active when you have the mouse pointer at the top of a track, will move just
that clip and nothing else, therefore leaving a gap where the clip was and covering any clips that
are in the position you move the selected clip to.
YELLOW SEGMENT MODE, active when you have the mouse pointer at the bottom of a track, will
re-arrange the rest of the timeline to accommodate the clip you’re moving. If you’re not careful this
can put things out of sync.
Next to the segment tools are the TRIM MODE tools. These are active when you have the mouse
pointer at the edge of a clip, and are used to shorten or extend a clip. Again the red one will be
active when the mouse pointer is at the top of a track and the yellow one at the bottom, and like
the segment tools the red one will leave a gap or cover the other clips, depending on which way
you’re dragging, and the yellow one will move the other clips in the timeline to accommodate the
change you’re making. Again, this could put things out of sync if you’re not careful. You can
however use the SYNC LOCKS to avoid this.
Next along are the EXTRACT (x) and LIFT (z) buttons. EXTRACT will remove a marked section in
the timeline and close the gap. LIFT will remove a marked section and leave a gap.

LINK SELECTION TOGGLE - With this active the software will automatically select any associated
sound when you click on a video clip with the SEGMENT MODE tools (and vice versa).
MARK CLIP (t) – This will place IN and OUT marks around the clip/s that the playhead is currently on
and whose tracks are active ie selected in the track patch panel.
CLEAR MARKS (g) – Clears any IN/OUT marks in the timeline.
ADD EDIT – Makes a cut at the playhead position on any tracks selected on the timeline side of the
TRACK PATCH PANEL (see below).
TRIM MODE – toggles in and out of TRIM MODE
TRANSITION MANIPULATION Smart Tool – With this button active you can adjust transitions in the
timeline directly with the mouse. The mouse pointer icon will change to indicate whether you are
going to reposition it (a hand) or adjust the duration (a double headed horizontal arrow).
EFFECT MODE - opens the effect editor window
MOTION EFFECT EDITOR – Opens the motion effect editor window for creating and modifying
speed changes.
TITLER+ - Opens the Avid Titler+ interface.
QUICK TRANSITION – Opens the transition editor allowing you to create or modify transitions.
RENDER EFFECT – Renders the effect/s at the current playhead position or in the marked section.
REMOVE EFFECT – Removes the effect/s at the current playhead position or in the marked section.
AUDIO DUCKING – automatically lowers the audio levels on selected tracks for a marked section
KEYFRAME MANIPULATION Smart Tool – With this button active you can use the mouse to adjust
audio keyframes in the timeline.
To the left of the buttons is an audio level meter and some associated function buttons.
Below the row of buttons is a timecode bar.
The left-hand side has a timecode display
which tells you the timecode of the current
playhead position and the ‘ruler’ above the
actual timeline shows the timecode of that part of the sequence.
Between these there’s a small disclosure
triangle which opens up some extended audio
controls, the TRACK CONTROL PANEL (further
details below).

To the left of the actual timeline itself is the TRACK PATCH PANEL.
This is used to determine which tracks are active when performing functions in
the timeline, including which tracks objects edited into the timeline are placed on.
The diagonal slash buttons are the SYNC LOCKS and with these active those tracks
will maintain sync when trimming even if you haven’t selected them.
For the video tracks there is a VIDEO TRACK MONITOR button which determines
which layer of video you are monitoring and for audio tracks there are SOLO and
MUTE buttons that allow you to choose which audio tracks you are monitoring.
If you’ve clicked the TRACK CONTROL PANEL button mentioned above then you will also have buttons for
deactivating tracks entirely and, on the audio tracks, buttons for switching on waveform display and audio
keyframe display.
If you click on one of the five empty buttons below the waveform and keyframe buttons you can activate
real-time audio effects on a track by track basis.
At the bottom of the Timeline Window there are sliders to zoom in or out on the timeline and to scroll
along it when zoomed in.
On the left hand side there are;

•

A fast menu button to access various timeline display options

•

The Sequence name, raster dimensions and framerate.

•

FOCUS button to snap the timeline window to the playhead position

•

TOGGLE SOURCE/RECORD IN TIMELINE button to enable you to view the source clip in the timeline
window – mainly used to view the audio waveform of a source clip.

•

VIDEO QUALITY MENU button to choose the video quality you’re monitoring your timeline in.

•

TOGGLE CLIENT MONITOR button to switch an external video output on and off.

•

STEP IN/OUT buttons – used when working with nested (layered) effects.

There is also a drop down menu for choosing any timeline display presets you have, and a search field
used for quickly locating objects in the timeline.
At the Right of the screen there are buttons for switching between the different task-specific workspaces.
•

EDIT MODE – The regular assembly editing mode

•

COLOUR CORRECTION MODE – used for colour correction

•

EFFECTS MODE – used when applying effects and adjusting effect parameters

•

AUDIO MODE – used when adjusting audio levels and keyframes

NOTE – You can also access many of the individual task-specific controls by using the ‘Tools’ menu.

INGESTING CAMERA FOOTAGE
1. When you first enter a project Avid will have automatically created a single bin (the containers that
clips and sequences exist in) named ‘<Project Name> Bin’. Rename it to something meaningful ie
Sequences or CARD1, depending on what you’re going to use it for.
2. If you insert an SD card Avid should recognise this as a camera card and automatically open a new
bin and populate it with the clips. If so you can jump to step 7. If it doesn’t then go to step 3.
4. To bring in your footage you need to use the Source Browser. This should open automatically when
you first enter the project, however if it’s not visible you can open it by either going
‘File>Input>Source Browser’ or by Right-clicking in a bin and choosing ‘Input>Source Browser’.

5. In the Source Browser navigate to your Camera Card (or folder) and your clips should populate the
right hand column. Depending on the card/camera type you may have to navigate to the ‘PRIVATE’
folder and/or click the ‘view folders as media volumes’ button.

6. In the Source Browser you can preview the clips (by double-clicking the icon to load them in the
source monitor) to select those you want.

7. Once you’ve highlighted the clips you want make sure that the ‘Link’ option is selected at the
bottom left of the source browser and then click the ‘Link’ button at bottom right of the Source
Browser to bring your clips into the selected target bin.
8. You can now edit with your footage but you’ll get better performance if you transcode the clips to
native Avid Media. To do this select the clips in the bin and;
EITHER right-click on one of them, and from the contextual menu that appears select the
‘Consolidate/Transcode’ option.
OR go to the clips menu and select the ‘Consolidate/Transcode’ option.

9. In the Consolidate/Transcode window select the ‘Transcode’ option and the relevant destination
drive (usually z:<module volume>). Check the box for ‘keep source’s frame rate’ and choose the
appropriate codec (usually DNxHR SQ). Click ‘Transcode’.

10. Once the transcode has completed make a new bin for the transcoded clips and move them into it.
Make sure you know which are which – the Linked clips have a chain link on the icon and the
transcoded ones don’t, but should have a horizontal line underneath to signify that they’re on the
server.

Linked clip

Transcoded clip on the server

Transcoded clip on the local drive
•

Once you’ve separated the two types of clips CLOSE the bin containing the linked files so that you
don’t inadvertently end up using them in your edit.

INGESTING AUDIO FILES
While you can ingest audio files following the method described above for camera files it is not strictly
necessary to follow the link-transcode workflow and you can simply select the ‘Import’ option instead of
‘Link’ and that will bring the clips into the target bin and create Avid media at the same time. The only
difference is that when you select the ‘Import’ option you’ll get an extra field to select the drive that Avid
creates the media on, just like in the transcode window.
Alternatively you can simply drag the clips from a Windows Explorer/Mac Finder window to a bin. This will
perform an import using your previously selected settings. **NB This is not recommended for video files**

EDITING YOUR MATERIAL
•

To edit with your clips you need to open them in the SOURCE MONITOR. To do this either drag the
icon/thumbnail from a bin to the source monitor or double-click on the icon/thumbnail in the bin.

•

To edit a clip into the timeline you mark an IN and OUT point in the clip to mark the beginning and
end of the section you wish to use, and one or the other in the timeline to determine where the clip
is placed. If you don’t make a mark in the timeline the playhead will function as an IN point.

MARK IN
•

MARK OUT

To decide which tracks in the timeline your clip goes to click and
drag the source track selector buttons to the desired timeline track
selector buttons to PATCH them.
In this example the source’s audio tracks are patched to A1 and A2
in the timeline and the video track is patched to V1. However
because V1 in the timeline is inactive the video track won’t be
edited in.

•

Hit V or B on the keyboard or use the Splice-in or Overwrite buttons in the Interface to add your clip
to the timeline.

•

To move clips around in the timeline use the segment modes.

Red will leave everything else in place as you move the selected clip/s.
Yellow will re-arrange the other clips in the timeline to compensate for the clip/s you’re moving.

•

Use the TRIM Smart Tools or Trim mode to shorten or extend clips in the timeline.

Again, Red will leave everything else in place as you adjust the selected clip/s and
Yellow will re-arrange the other clips in the timeline to compensate for the clip/s you’re trimming.
REMEMBER If you accidentally do something wrong you can UNDO by clicking ctrl+z or by going to
the undo list in the edit menu.

Working with Audio
You can adjust your audio levels in a few ways.
•

Go to the Tools menu and select ‘Audio Mixer’. This opens the audio mixer which enables you to set
the audio level and panning, amongst other things.
If you have the source window active when you’re working in the audio mixer it will adjust the
level/pan of the clip in the bin and these changes will persist ie if you open that clip again at a later
date that level/pan will still be set. This is handy for setting the level of music or sound effects that
may be too loud by default.
If you have the record window active when you work in the audio mixer it will only affect the clips
that are under the playhead in the timeline and won’t alter the levels or panning of the original
clips in the bin. This is used for evening out or adjusting the levels in your edited film.
If there is no audio on a particular track at the point in the timeline that you’ve got the playhead
then the pan and level controls won’t appear for that track.

•

Another way to adjust the levels is to use the timeline track mixers. These are essentially a shortcut
to the audio mixer accessible from each audio clip in the timeline. You can enable these in two
ways;

•

You can enable them for all tracks by going to the
Timeline fast menu at the bottom left of the timeline
window and choosing Audio Data>Clip Gain.
This adds an icon to the bottom left of each audio
segment in the timeline which when clicked opens a
mini level fader. Adjusting the level here will change
the fader position in the main audio mixer too.

•

Or you can activate the timeline track mixers on a per track basis by using the Track Control Panel
1. Click the ‘Track Control
Panel’ disclosure triangle at
the top left of the timeline
window (shown below).

2. In the Track Control Panel
click on the middle button
and choose ‘Clip Gain’

Viewing Waveforms
When working with audio it can be helpful to make the audio waveforms visible. This can help you locate
the beginning of words or any loud noises etc. You do this from the same menu as the Clip Gain function ie
either from the timeline fast menu or from the Track Control panel. Go to the menu and choose
‘Waveform’
Making complex level adjustments
You can make complex level adjustments using keyframes. To do this you activate the ‘Volume’ option
from the same menus where you activate waveforms and Clip Gain. Once you’ve activated this you can
add keyframes to audio tracks by clicking the keyframe key on the keyboard (the ‘ “ key just above the
right hand shift button) or by clicking the keyframe button in the Avid interface.
In order to manipulate the keyframes you need to have the keyframes tool button selected above the
timeline
and you need to have the relevant tracks active ie highlighted in the TRACK PATCH PANEL at
the left of the timeline.
If you click and drag a keyframe you can move it up and down, if you want to move it sideways you have to
hold down alt on the keyboard before clicking the keyframe.
You can select multiple keyframes by shift-clicking or by dragging a lasso/marquee around the relevant
keyframes. If you have an in-out range marked Avid will automatically select all keyframes on
active/highlighted tracks within that range.

SYNCING FILES
1. In the “video and sound files” bin, identify the audio clip that goes with the video clip (if both have
time of day timecode you can use that, or you can check your log sheet!).
2. Double click the audio clip, so that the it goes into the source monitor of the composer window.

Fig. 3, Avid timeline window
3. At the bottom of the TIMELINE window, toggle the SOURCE/RECORD BUTTON (fig. 3) to show
source (the clip now appears on the timeline).
4. Click on the TIMELINE FAST MENU (fig 3), select AUDIO DATA > WAVEFORM (you should now see a
histogram of the audio in the timeline, the clapperboard clap should be noticeable here—it is a
spike in the audio).
5. Go to the spike (you can hold down the SHIFT key to scrub the audio, i.e. hear it cueing). Mark this
as your in point.
6. Now load the corresponding video clip into the source monitor. Scroll on the timeline to the point
where you can see the clapperboard sticks close. It should be obvious because at the moment they
made contact, the image loses it motion blur. Mark your in point here.
7. Now in the bin, select both the video and audio clips by shift clicking them. Then right click on the
highlighted clips and select AUTOSYNC from the drop down menu. A dialogue box will open. From
the options choose INPOINTS and press OK. A synced subclip is created with which you can now
edit.
8. If you want, you can copy or move your synced sub-clips to a new bin to work. But be careful;
sometimes there are master clips with no audio, and you might forget about these if they are left in
a bin you do not use often. You can also just hide certain selected clips in a bin if you want to cut
down on the number of visible clips cluttering up the view – search the help files (go to
file:///Applications/Avid%20Media%20Composer/Help/MCHelp.html in a browser or choose
‘Media Composer Family Help’ from the help menu) for Bin Display and Sift. The Sift function
enables you to choose to display specific items while the Bin Display settings allow you to switch off
the visibility for specific types of items eg Master clips, Subclips

Exporting
Avid has an enormous number of different export options to cover a wide variety of workflows and uses.
What follows here is intended to provide a reasonable compromise between the complexity of the
process, speed of export, picture and sound quality, and broad compatibility of the end file. It is a safe
option for most student work but if you need better quality, a fast export, or to adhere to specifications
provided by a film festival or broadcaster please approach the tech team for advice.
PLEASE NOTE – there are instructions on how to obtain a full quality file at the end of this document, but
this file will be very large and only suitable for specific workflows and purposes.
Preparing your Sequence for export
1. Load your sequence into the timeline and confirm that it’s the correct version.
2. Make a ‘MARK IN’ at the start of the sequence and a ‘MARK OUT’ at the end.
3. Make sure all sequence tracks are active ie highlighted in the right hand column of the TRACK
PATCH PANEL.
4. Right-click in the timeline window and select ‘RENDER>EXPERT RENDER IN/OUT’ from the pop-up
menu, and then click ‘OK’ in the following window. If the window says ‘NO EFFECTS TO RENDER’
you can just click ‘CANCEL’.
Exporting your Sequence
1. Right-click on the image in the RECORD MONITOR and select
‘EXPORT…’ from the pop-up menu.

2. In the next window
check that the name
of your export is
correct and that it will
be saved to the
correct location as
specified by the
module co-ordinator
or lecturer.

3. From the pop-up
menu at the bottom
of the window select
‘UNTITLED’ and then
click the ‘OPTIONS…’
button just below.

4. In the next window go to the ‘EXPORT AS:’ drop-down menu and choose ‘MOV’ from the bottom of
the list, then set the options as below.
‘Use Marks/Selected Tracks’ – use these to limit your
export to a chosen section or tracks

Set the Video Levels to ‘Keep as Legal Range’
Set the Codec Family and Compression to ‘H.264’
Set your Target bit rate between 6-20 Mbps.
If using ‘Variable Bit Rate’ set the Max bit rate to
around 2Mbps higher than the Target bit rate.
Set the Audio Format to ‘AAC’

Click ‘SAVE’ (or ‘SAVE AS..’ if you want to save these
settings as a new preset.)

5. Finally, click ‘SAVE’ on the ‘EXPORT AS…’ window to start your export.

Exporting for vfx, grading or encoding in
other software.
If you want to export your film at high quality
for use in another piece of software, e.g. for VFX
or colour correction, follow the instructions as
above but at the window in step 4 choose Apple
ProRes or DNxHR as the ‘CODEC FAMILY’.
Your choice of compression will depend on your
source material and the purpose of the export.
The technical team can advise on individual
cases but for the most part either ProRes
422/ProRes 422 (HQ) or DNxHR SQ/DNxHR HQ
are suitable for the University’s cameras.
Set the COLOR DEPTH to 10 bit.
Set the Audio options according to your needs.
PCM is best quality.
Click ‘SAVE’, or ‘SAVE AS..’ if you want to save
these settings as a preset, then proceed to Step
6 in the instructions above.

